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1 Locating HP resources

This section provides information on the following HP resources for your workstation:

Topics

Product information on page 2

● HP Cool Tools

● Regulatory information

● Accessories

● System board

● Serial number and Certificate of Authenticity labels

● Linux

Product support on page 3

● Additional information

● Technical support

● Business Support Center

● IT Resource Center

● HP Service Center

● HP Business and IT Services

● Warranty information

Product documentation on page 4

● User and third-party documentation, and white papers

● Product notifications

● QuickSpecs

● Customer Advisories, Security Bulletins, Notices

Product diagnostics on page 5

● Diagnostics tools

● Audible beeps and LED code definitions

● Web-based support tools

Product updates on page 6

● Software, BIOS, and driver updates

● Operating system reinstallation

● Operating system
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Product information
Table 1-1  Product information

Topic Location

HP Cool Tools Most HP Microsoft Windows workstations are preloaded
with additional software that is not automatically installed
during first boot. Additionally, a number of valuable tools on
your workstation are preinstalled that may enhance system
performance. To access or learn more about these
applications, choose one of the following options:

To learn more about these applications, click HP Cool
Tools—Learn More.

To install or launch the applications, click the appropriate
application icon.

● Click the HP Cool Tools icon on the desktop, or

● Open the HP Cool Tools folder by selecting Start >
All Programs > HP Cool Tools.

Regulatory information Refer to the Safety & Regulatory Information guide for
product Class information. You can also refer to the label on
the workstation chassis.

Accessories For complete and current information on supported
accessories and components, seehttp://www.hp.com/go/
workstations.

System board A diagram of the system board is located on the inside of
the side access panel. Also, additional information is located
in the Service and Technical Reference Guide on the Web
at http://www.hp.com/support/workstation_manuals/.

Serial number and Certificate of
Authenticity (COA) labels (if
applicable)

Serial number labels are on the top panel, or on the side of
the unit at the rear, depending on the workstation model.
The COA label is generally located on the top or side panel
near the serial number label. Some workstations have this
label on the bottom of the unit.

Linux For information on running Linux on HP workstations,
seehttp://www.hp.com/linux/.
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Product support
Table 1-2  Product support

Topic Location

Additional information For online access to technical support information and tools,
see http://www.hp.com/go/workstationsupport.

Support resources include Web-based troubleshooting
tools, technical knowledge databases, driver and patch
downloads, online communities, and proactive notification
services.

The following communication and diagnostic tools are also
available:

Refer to the workstation Service and Technical Reference
Guide for more information on how to receive support.

● Instant Chat

● Instant Support

● Diagnose Problem

Technical support Before you call technical support, refer to the workstation
Service and Technical Reference Guide for a listing of
information you need to have available before you call.

For a listing of all worldwide technical support phone
numbers, see http://www.hp.com/support/, select your
region, and click Contact HP in the upper-left corner.

Business Support Center (BSC) For software/driver downloads, warranty information,
single-topic documents, user manuals, or service manuals,
see http://www.hp.com/go/bizsupport.

IT Resource Center (ITRC) See http://www.itrc.hp.com/ for a searchable knowledge
base for IT professionals.

HP Business and IT Services. For business and IT information, seehttp://www.hp.com/
hps/.

HP Hardware Support Services For hardware service information, seehttp://www.hp.com/
hps/hardware/.

Warranty information To locate base warranty information,
seehttp://www.hp.com/support/warranty-lookuptool.

To locate an existing Care Pack, seehttp://www.hp.com/go/
lookuptool.

To extend a standard product warranty,
seehttp://www.hp.com/hps/carepack. HP Care Pack
Services offer upgraded service levels to extend and
expand a standard product warranty.
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Product documentation
Table 1-3  Product documentation

Topic Location

HP user documentation, white
papers, and third-party
documentation

For the latest online documentation, seehttp://www.hp.com/
support/workstation_manuals. These include this Setup
and Troubleshooting Guide and the Service and Technical
Reference Guide.

Product notifications Subscriber's Choice is an HP program that allows you to
sign up to receive driver and software alerts, proactive
change notifications (PCNs), the HP newsletter, customer
advisories, and more. Sign up at http://www.hp.com/go/
subscriberschoice/.

Customer advisories and product change notifications are
also available on http://www.hp.com/go/bizsupport/.

Workstation QuickSpecs The Product Bulletin contains QuickSpecs for HP
Workstations. QuickSpecs provide an overall specification
review of your product. It includes information about its
features including the operating system, power supply,
memory, CPU, and many other components of the system.
To access the QuickSpecs, seehttp://www.hp.com/go/
productbulletin/.

Customer Advisories, Security
Bulletins, and Notices

To find advisories, bulletins, and notices:

1. see http://www.hp.com/go/workstationsupport.

2. Select the desired product.

3. From the Resources section, select See more…

4. Use the scroll bar to select Customer Advisories,
Customer Bulletins, or Customer Notices.
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Product diagnostics
Table 1-4  Product diagnostics

Topic Location

Diagnostics tools The HP Vision Field Diagnostics utility can be downloaded
from the HP Web site. To use this utility, refer to the
appropriate section of the workstation Service and
Technical Reference Guide.

Audible beep and LED code
definitions

Refer to the appropriate section of the workstation Service
and Technical Reference Guide for detailed information
about beep and Light Emitting Diode (LED) codes
applicable to the workstation.
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Product updates
Table 1-5  Product updates

Topic Location

Software, BIOS, and driver
updates

See http://www.hp.com/go/workstationsupport to verify that
you have the latest drivers for the workstation.

To locate the current workstation BIOS on your Microsoft
Windows workstation, select Start>Help and Support>Pick a
Task>Use Tools to view...>Tools>My Computer
Information>View general system information....

Operating system For information on operating systems supported on HP
workstations, see http://www.hp.com/go/wsos.
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2 Setting up the Hardware

This chapter provides information on setting up of the workstation hardware.

Quick setup
WARNING! To reduce the risk of electric shock or damage to your equipment:

— Do not disable the power cord grounding plug. The grounding plug is an important safety feature.

— Plug the power cord in a grounded (earthed) outlet that is easily accessible at all times.

NOTE: Your workstation might not have PS/2 mouse and keyboard connectors as shown in Figure
2–1. Alternatively, connect the mouse and keyboard to appropriate USB connectors (see Table 2–2).

Figure 2-1  Workstation quick setup example

NOTE: After setting up your workstation hardware, connect other peripheral components (such as a
printer) according to the instructions included with the device. For more information on your HP
Workstation, see the Documentation and Diagnostics CD or visit http://www.hp.com/go/
workstationsupport.
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To rapidly set up your workstation hardware, complete the following steps:

1. After unpacking your HP Workstation, locate an accessible workspace to set up the system and
connect the mouse, keyboard, and power cables to your workstation. Connect the power cable
from the workstation to a power outlet.

2. Connect the workstation monitors, as appropriate for your system configuration, as follows:

● If your workstation has a PCI-Express graphics card with a DMS-59 output receptacle (see
Table 2–2), use an appropriate adapter to connect your monitors. Adapters are available to
connect the DMS-59 output to two DVI or two VGA monitors. Figure 2–1 (lower inset)
illustrates using an adapter to connect dual DVI or VGA monitors to the workstation DMS-59
output.

● If your workstation has a PCI-Express graphics card with two DVI output receptacles (see
Table 2–2), you can connect a monitor to each DVI receptacle (using appropriate adapters,
if required).

NOTE: On a system with two DVI connections, the primary display port (used to display
BIOS and other important information) will be port #1; defined as the port physically closest
to the system board, and located on the PCI-Express card bulkhead installed closest to the
workstation chassis rear panel.

● If your workstation does not have a PCI-Express graphics card, but, alternatively, has an
SVGA (see Table 2–2) and a DVI-D output receptacle located on the workstation chassis rear
panel, you can connect a monitor to each output.

3. Connect a power cable from each monitor to a power outlet, as shown in Figure 2–1.

Ventilation, COA label, and serial number label information
Proper ventilation for your system is very important. See Figure 2–2 and the following notes to properly
position your system for maximum airflow.

● Operate the computer on a sturdy, level surface.

● Place the computer in an area that is relatively cool with adequate ventilation. Provide at least 6
inches of clearance at the front and back of the workstation. For cabinet installation, ensure
adequate cabinet ventilation and ensure that the ambient temperature within the cabinet does not
exceed 35o C (95o F).
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● Never restrict the incoming or outgoing airflow of the computer by blocking any vents or air intakes.

Figure 2-2  Workstation ventilation

Each HP Workstation has two unique serial number labels (1) and a Certificate of Authentication (COA)
label (2) (for Windows®-preinstalled systems only) as shown in Figure 2–2. In general, the serial number
labels can be found on the top panel or on the side of the unit and at the rear of the unit. Keep this
number available when contacting customer service for assistance. The COA label is generally located
on the top panel or side of the unit near the serial number label.

NOTE: If you must restore the operating system with Windows OEM CDs (installing without using
the Restore Plus! CDs), refer to the appropriate section of the chapter {Xref Error! Target does not
exist.}.

Front and rear panel components
This section provides information on workstation front and rear panel controls and components.
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Front panel components
Figure 2–3 is for reference only, and shows examples of different workstation series. Your HP
workstation might look different.

Figure 2-3  Workstation series front panel examples

xw4000 Series xw6000 Series xw8000/xw9000 Series

Table 2-1  Front panel component examples*

Item Symbol Description Item Symbol Description

1  Optical drive 6 Headphone connector

2  5.25-inch drive bay 7 USB 2.0 (Universal Serial Bus) ports

3  Diskette drive (optional) 8 Hard drive activity light

4 IEEE-1394a connector 9 Power button

5 Microphone connector 10  Power on light

* Refer to the Service and Technical Reference Guide for your workstation for specific front panel component information.
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Rear panel components
Figure 2–4 is for reference only and show examples of rear panel connectors that might be located on
your workstation. Your HP workstation has some combination of these connectors, depending upon
workstation model and configuration.

Figure 2-4  Workstation connector and control examples

Table 2-2  Rear panel connector and control description

Item Symbol Description Item Symbol Description

1  Power cord connector 10 Audio line-out connector

2  Voltage Select Switch 11 Audio line-in connector

3 PS/2 Mouse connector (green)

NOTE: Might not be available on all
workstations.

12 DVI DVI-D Monitor Connector

NOTE: Your workstation might have
a DVI-I Monitor Connector instead.
This connector will have two additional
pins above and two below the
horizontal flat blade to carry integrated
analog signals.

4 PS/2 Keyboard connector (purple)

NOTE: Might not be available on all
workstations.

13  e-SATA Connector

NOTE: Might not be available on all
workstations.

5 USB 2.0 ports 14  Mini SAS Connector

NOTE: Might not be available on all
workstations.

6 Serial connector 15 IEEE-1394a connector

NOTE: Might not be available on all
workstations.
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Item Symbol Description Item Symbol Description

7 RJ-45 network connector 16  SAS Connector

NOTE: Might not be available on all
workstations.

8 Parallel connector *

NOTE: Might not be available on all
workstations.

17  DMS–59 high density graphics
connector

NOTE: Might not be available on all
workstations.

9  SVGA Monitor Connector    

* Refer to the Service and Technical Reference Guide for your workstation for specific rear panel component information.
The rear panel connectors are labeled with industry-standard icons and colors to assist you in connecting your peripheral
devices.

Additional rear panel components can include those shown in the examples in Figure 2–5. Your
workstation has some combination of these components, depending upon workstation model and
configuration.

Figure 2-5  Additional rear panel component examples

 xw4000 Series xw6000 Series xw8000/xw9000 Series

Item Description

1 Built-in Self Test (BIST) LED

2 Universal chassis clamp opening

3 Cable lock slot

4 Padlock loop

Table 2-2  Rear panel connector and control description (continued)
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5 Access panel key

NOTE: Not all workstations models have the key lock.

6 PCI expansion slot access openings (each slot opening typically covered with blank filler panel when not use).

Product recycling
HP encourages customers to recycle used electronic hardware, HP original print cartridges, and
rechargeable batteries.

For information about recycling HP components or products, see http://www.hp.com/go/recycle.
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3 Setting up the operating system

This chapter provides setup and update information for the workstation operating system. It includes
these topics:

Topics

Setting up the Microsoft operating system on page 15

Setting up Red Hat Enterprise Linux on page 16

Setting up Novell SLED on page 17

Updating the workstation on page 17

This chapter also includes information on how to determine that you have the latest BIOS, drivers, and
software updates installed on the workstation.

CAUTION: Do not add optional hardware or third-party devices to the HP workstation until the
operating system is successfully installed. Adding hardware might cause errors and prevent the
operating system from installing correctly.
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Setting up the Microsoft operating system
NOTE: If you ordered a downgrade from Windows Vista to Windows XP Professional operating
system, your system will be preinstalled with Windows XP Professional operating system. With this
configuration, you will receive recovery media for Windows Vista operating system only. In case you
need to restore or recover the Windows XP Professional operating system in the future, it is important
that you create recovery media disks for Windows XP Professional operating system after first boot.

When you first apply power to the workstation, the operating system is installed. This process takes
approximately 5 to 10 minutes. Carefully follow the instructions on the screen to complete the installation.

CAUTION: After installation has started, do not turn off the workstation until the process is complete.
Turning off the workstation during installation can damage the installation and operation of the software.

For complete operating system installation and configuration instructions, see the operating system
documentation that was provided with the workstation. Additional information is available in the online
help tool after you successfully install the operating system.

Installing or upgrading device drivers
To install hardware devices after the operating system is installed, you must install the appropriate
device drivers before you install the devices. Follow the installation instructions that came with the
device. In addition, for optimum performance, your operating system must have the most recent updates,
patches, and software fixes. For additional driver and software update information, refer to Upgrading
device drivers on page 19.

Transferring files and settings to your Windows workstation
The Microsoft Windows operating system offers data migration tools that helps you choose and transfer
files and data from a Windows computer to your Windows Vista or Windows XP Professional operating
system workstation.

For instructions on how to use these tools, see the documents at http://www.microsoft.com.
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Setting up Red Hat Enterprise Linux
HP offers an HP Installer Kit for Linux (HPIKL) to supplement Red Hat box sets and help HP Linux
customers customize their system image. The HPIKL contains the HP driver CD and device drivers to
successfully setup up the Red Hat Enterprise Linux (RHEL) operating system, The HP Installer Kit for
Linux CDs are currently available for download at http://www.hp.com/support/workstation_swdrivers.

Installing with the HP driver CD
To install the HP driver CD, see “Installing with the HP Installer Kit for Linux” in the HP Workstations for
Linux manual at http://www.hp.com/support/workstation_manuals.
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Installing and customizing Red Hat-enabled workstations
Linux-enabled workstations require the HP Installer Kit and the purchase of a Red Hat Enterprise Linux
box set. The Installer kit includes the HP CDs necessary to complete the installation of all versions of
the Red Hat Enterprise Linux box set that have been qualified to work on an HP workstation.

To use the drivers in the HP Installer kit for Linux other than RHEL, you must manually extract the drivers
from the HP Driver CD and install them. HP does not test the installation of these drivers on other Linux
distributions nor does HP support this operation.

Verifying hardware compatibility
To see which Linux versions have been qualified to work on HP Workstations visit http://www.hp.com/
support/linux_hardware_matrix.

Setting up Novell SLED
To set up the SUSE Linux Enterprise Desktop (SLED) on systems preloaded with the operating system:

1. Boot the workstation.

2. Start the Installation Settings and enter the password, network, graphics, time, keyboard settings,
and Novell Customer Center Configuration for the workstation.

NOTE: During Installation Settings after the first time after booting the system the Novell
subscription can be activated from the Novell Customer Center Configuration screen. Visit the full
Novell Customer Center documentation at http://www.novell.com/documentation/ncc/.

Updating the workstation
HP is constantly working on improving your total workstation experience. To ensure that the workstation
leverages the latest enhancements, HP recommends that you install the latest BIOS, driver, and
software updates on a regular basis.

Updating the workstation after first boot
After successfully booting the workstation for the first time, you should follow these guidelines to ensure
that the workstation is up-to-date:

● Ensure that you have the latest system BIOS loaded. See Upgrading the BIOS on page 17 for
instructions.

● Ensure that you have the latest drivers for your system. See Upgrading device drivers
on page 19 for instructions.

● Become familiar with your available HP resources.

● Consider a subscription to Driver Alerts at http://www.hp.com/go/subscriberschoice.

Upgrading the BIOS
For optimum performance, determine the BIOS revision on the workstation, and upgrade it if necessary.
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Determining current BIOS
To determine the current BIOS of the workstation during system power up:

1. Wait for F10=setup to appear on the lower right corner of the screen.

2. Press F10 to enter the F10 Setup utility.

The F10 Setup utility displays the workstation BIOS version under File > System Information.

3. Note the workstation BIOS version so that you can compare it with the BIOS versions that appear
on the HP website.
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Upgrading BIOS
To find and download the latest available BIOS, which includes the latest enhancements:

1. Go to http://www.hp.com/go/workstationsupport.

2. Select Download Drivers and Software from the left menu column under Tasks.

3. Follow the instructions to locate the latest BIOS available for the workstation.

4. If the BIOS on the Web site is the same as the version on your system, no further action is required.

5. If the BIOS on the Web site is a version later than the one on your system, download the appropriate
version for the workstation. Follow the instructions in the release notes to complete the installation.

Upgrading device drivers
If you install a peripheral device (such as a printer, display adapter, or network adapter), confirm you
have the latest device drivers loaded. If you purchased your device through HP, visit the HP Web site
to download the latest drivers for your device. These drivers have been tested to ensure the best
compatibility between your device and your HP workstation.

If you did not purchase your device from HP, HP recommends visiting the HP Web site first to see if
your device and its drivers have been tested for HP workstation compatibility. If no driver is available,
visit the device manufacturer's Web site to download the latest drivers.

To upgrade device drivers:

1. Go to http://www.hp.com/go/workstationsupport.

2. Select Download Drivers and Software from the left menu column under Tasks.

3. Follow the instructions to find the latest drivers available for the workstation.

If a needed driver is not found, see the Web site of the manufacturer of the peripheral device.
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4 Restoring the operating system

This chapter describes how to restore the Windows or Linux operating system. It includes these topics:

Topics

Restore methods on page 20

Ordering backup software on page 21

Restoring Windows Vista on page 21

Restoring Windows XP Professional on page 22

Restoring Novell SLED on page 24

Restore methods
The Windows Business Vista operating system can be reinstalled using the HP RestorePlus! process.
The Windows XP Professional operating system can be reinstalled using the RestorePlus! process or
the HP Backup and Recovery Manager.

● RestorePlus!

The RestorePlus! process reinstalls the Windows operating system and device drivers (for devices
included with the system) to a near-factory state. The process does not back up or recover data
on the hard drive. Some application software might not be restored using this process and must
be installed from the appropriate application CD.

● HP Backup and Recovery Manager (HPBR) Recovery Point

The HP Backup and Recovery Manager application can be used to capture and restore the contents
of the system partition. It captures a snapshot of the system partition and stores it in a Recovery
Point. Everything on the system partition at the time the recovery point was made is saved.

NOTE: HP Backup and Restore is only supported on the HP xw6600 and xw8600 Workstations.

The Recovery Point is saved to the hard drive and can be burned to media for safekeeping.

CAUTION: These methods restore the operating system, but not data. Data must be backed up
regularly to avoid loss.
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Ordering backup software
If you cannot create system recovery CDs or DVDs, you can order a recovery disk set from the HP
support center. To obtain the support center telephone number for your region seehttp://www.hp.com/
support/contactHP.

Restoring Windows Vista
This section describes how to restore Windows Vista.

Ordering the RestorePlus! media
If you ordered restore media with your workstation, the media is included with your workstation
components.

If you did not order restore media, call HP Support and request a RestorePlus! media kit. For worldwide
technical support phone numbers, see http://www.hp.com/support.

Restoring the operating system
NOTE: Windows Vista provides a backup and restore application as well. To learn more about this
application, see the Microsoft Web site.

CAUTION: Before you restore the operating system, back up your data.

When you run RestorePlus! from media, the process deletes all information on the primary hard drive,
including all partitions.

To restore Windows Vista:

1. Boot from the RestorePlus! DVD to start the RestorePlus! process. You must start from the
RestorePlus! DVD to install device drivers and settings.

2. Follow the prompts to restore your operating system.

Some application software might not be restored using this process. If software is not restored, install
it from the appropriate application DVD.
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Restoring Windows XP Professional
This section describes how to restore the Windows XP Professional operating system.

NOTE: The workstation must have a CD or DVD writer installed to create the media set.

Creating RestorePlus! media
The RestorePlus! kit can be created using the files contained on the hard drive. To create the restore
media:

1. Boot the workstation.

2. During boot up, an HP Backup and Recovery Manager screen is displayed prompting you to create
Recovery CDs or DVDs. Select Now.

3. An Initial Recovery Point (IRP) of the system is captured. This is a snapshot of the system hard
drive. The capture can take more than 10 minutes.

4. After the IRP is created, you can create a set of backup CDs or DVDs.

To create a RestorePlus! media set including the Windows XP operating system CD, select
RestorePlus! > Microsoft Windows XP operating system > Supplemental media.

NOTE: Depending on the options, there might be additional DVDs you can create.

5. Follow the prompts to create RestorePlus!, operating system, and HPBR media.

If you are unable to create CD/DVDs on your workstation, call HP Support and request a RestorePlus!
media kit. For worldwide technical support phone numbers, see http://www.hp.com/support.
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Creating HP Backup and Recovery (HPBR) media
NOTE: HPBR is only supported on Windows XP systems. For details, refer to the documentation on
the Supplemental Software - HP Backup and Recovery CD included with the workstation. The
documentation can be accessed during installation.

The Initial Recovery Point can be burned to optical media and used to recover a system. This section
describes making the media.

NOTE: The workstation must have a CD or DVD writer to create the media set.

To create HPBR recovery media:

1. The Initial Recovery Point was captured when the RestorePlus! media set was created previously.

If the IRP was not created, start the HP Backup and Recovery Manager and create recovery points
using the Expert mode. Follow the HPBR online documentation for instructions.

2. Burn the IRP to media from HPBR.

Select HPBR Start > All Programs > HP Backup & Recovery > HP Backup and Recovery
Manager.

3. Select Next at the first screen.

Select Create recovery CDs or DVDs to recover the system, and then select Next.

4. Choose Next to display a list of available CD image and the recovery points.

5. Check the box next to Initial Recovery Point, and then select Next.

6. Follow the instructions to create the media.
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Restoring the operating system
CAUTION: Before you restore the operating system, back up your data.

When you run RestorePlus! from media, the process deletes all information on the primary hard drive,
including all partitions. If you run RestorePlus! from the recovery partition, only the root (C:) partition is
affected.

Using RestorePlus!
To restore with RestorePlus!:

1. Boot the workstation from the RestorePlus! DVD. You must start from the RestorePlus! DVD for
device drivers and settings to be installed.

2. Follow the prompts to restore the operating system.

Some application software might not be restored using this process. If software is not restored, install
it from the appropriate application DVD.

Using HPBR
To restore with the HPBR Initial Recovery Point media:

1. Boot the workstation from the Initial Recovery Point media.

2. Follow the prompts to restore the system to the state when the IRP was created.

Using the recovery partition
A system that shipped with Windows XP includes a recovery partition. You can boot the system from
that recovery partition.

From the recovery partition you can perform a system restore using the HPBR Initial Recovery Point, if
it was created. If it was not, you can use a RestorePlus! install.

To restore using the recovery partition:

1. Boot the workstation.

2. When prompted on the boot screen to enter the Recovery Manager, press F11.

TIP: The opportunity to press F11 during the boot process is small. It comes about the time the
F10 prompt appears.

NOTE: To ensure that the recovery processes reinstall on the correct hard drive, do not
disconnect the target drive during the recovery process.

3. Follow the prompts to restore the system to factory-like condition.

Restoring Novell SLED
The SLED restore media is required to restore the Linux operating system.

Creating restore media
THE SUSE Linux Enterprise Desktop preload includes a SUSE ISO icon on the desktop. You can click
this icon to go to the /iso directory. The /iso directory contains all iso images used to preload your
workstation. To recover or restore the original image, follow the instructions in the readme file in the /
iso directory to copy the ISO image file onto CDs.

24 Chapter 4   Restoring the operating system ENWW



NOTE: Make copies of the ISO recovery images on CD as backup files in case your workstation
experiences a hard drive failure.
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5 Troubleshooting

This chapter provides information on:

● Self-troubleshooting with HP Insight Diagnostics

● HP troubleshooting resources and tools

● Power-On Self Test (POST) error messages

● Basic troubleshooting tables

● Calling technical support

Self-troubleshooting with HP Vision Field Diagnostics
Hewlett-Packard Vision Field Diagnostics is a diagnostic tool that can be used by the end user or
technical support personnel to view information about the hardware configuration of the computer and
perform hardware troubleshooting on HP Desktop and Workstation systems. This diagnostic tool should
be used to help determine hardware failures. Accessible by either CD or USB key, these diagnostics
run outside the operating system and so make it easy to isolate potential issues that may be operating
system related versus hardware.

HP Vision Field Diagnostics benefits are:

● Capture complete system configuration information that can be shared as an HTML file, including:

◦ System serial number

◦ System product number

◦ System BIOS revision

◦ Memory size and configuration

◦ Processor information

◦ Storage device information and configuration

◦ Graphics / audio / communications information and configuration

◦ And more...

● Comprehensive list of diagnostic test available with new added features:

◦ Highly configurable testing options: quick / complete / custom / interactive / non-interactive

◦ Specific failing memory DIMM identification

◦ Tests video card memory

◦ Launches DST Smart tests for both SATA and SAS drives

◦ Many other tests and diagnostics

● Diagnostic Failure Code Output – A unique warranty code is generated for each failure which can
be used to validate diagnostic use for a specific system

● Easy to use - uses similar user interface as previous field diagnostics, HP Insight Diagnostics
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● True End2End diagnostics – same diagnostics modules used in factory

● Easy to obtain

◦ Download from Web

◦ USB key bootable or CD bootable

◦ Included with restore media

It is expected that these Vision diagnostics will be run on supported products when attempting to
troubleshoot system issues.

Overview
The HP Vision Field Diagnostics utility allows you to view information about the hardware configuration
of the workstation and perform hardware diagnostic tests on the subsystems of the workstation. The
utility simplifies the process of effectively identifying, diagnosing, and isolating hardware issues.

The Survey tab is displayed when you invoke HP Vision Field Diagnostics. This tab shows the current
configuration of the workstation. From the Survey tab, there is access to several categories of
information about the workstation. Other tabs provide additional information, including diagnostic test
options and test results. The information in each screen of the utility can be saved as an html file and
stored on a diskette or USB flash drive.

Use HP Vision Field Diagnostics to determine if all the devices installed on the workstation are
recognized by the system and functioning properly. Running tests is optional but recommended after
installing or connecting a new device.

You should run tests, save the test results, and print them so that you have printed reports available
before placing a call to the Customer Support Center.

NOTE: Third-party devices may not be detected by HP Vision Field Diagnostics.

ENWW Self-troubleshooting with HP Vision Field Diagnostics 27



Downloading and accessing HP Vision Field Diagnostics
Follow these steps to download the HP Vision Field Diagnostics utility from the HP Web site to a DVD
or USB, and then use it to perform diagnostics on the workstation:

1. Go to http://www.hp.com.

2. Select the Support & Drivers link.

3. Select the Download driver and software radio button.

4. Enter your product number in the text box, and then press Enter.

5. Select your operating system.

6. Select the Diagnostic link.

7. Locate HP Vision Field Diagnostics and select Download.

8. After the .iso file is downloaded, use CD-ROM burning software to copy the .iso file to an optical
medium or USB flash drive.

9. When the CD or USB flash drive has the utility installed, insert the CD or USB flash drive into the
workstation (while it is on).

10. Shut down the operating system and turn off the workstation.

11. Turn on the workstation. The system will boot into HP Vision Field Diagnostics.

NOTE: If the system does not boot to the CD in the optical drive or to the USB flash drive, you
may need to change the boot order. You may use the Computer Setup (F10) utility to change the
boot order, or you may press F9 to select the appropriate boot device.

12. At the boot menu, select either the HP Vision Field Diagnostics utility to test the various hardware
components in the computer or the HP Memory Test utility to test memory only.

NOTE: The HP Memory Test is a comprehensive memory diagnostic utility that is run as a stand-
alone application, outside of HP Vision Field Diagnostics.

If the workstation is booted from a CD, a separate boot CD will be required to use the memory
diagnostic. Hence, HP recommends that a USB key be used to boot the diagnostic utilities. It is
faster than using a CD, and it accommodates both Memory and Vision diagnostics.

13. If running HP Vision Field Diagnostics, select the appropriate language and click Continue.

14. In the End User License Agreement page, select Agree if you agree with the terms. The HP Vision
Field Diagnostics utility launches with the Survey tab displayed
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Accessing HP Vision Field Diagnostics on the workstation
The following procedures describe how to access the HP Vision Field Diagnostics utilities that are
included in the workstation software.

Creating and using a bootable USB key
This section describes how to use a USB key to access the HP Vision Field Diagnostics.

NOTE: Using a USB key is the most convenient method to access the HP Vision Field Diagnostics.

1. In the C:\VisionDiagnostics\ directory, double-click on VisionDiagUSB.exe. A setup menu appears.

2. Follow the setup prompts to create a bootable ISO image of the diagnostic utilities on a USB key.

3. Turn off the workstation and restart it with the USB key installed. The workstation will boot to the
USB key and initiate the HP Vision Field Diagnostics utility.

4. Follow the HP Vision Field Diagnostic prompts to troubleshoot the workstation.

Creating and using a bootable DVD
This section describes how to use a DVD to access the HP Vision Field Diagnostics.

1. In the C:\VisionDiagnostics\ directory, double-click on the VisionDiagISO.exe file. A setup menu
appears.

2. Follow the setup prompts to create a bootable ISO image of the diagnostic utilities on a DVD.

3. Enable the workstation to boot from DVD.

4. Turn off the workstation and restart it with the DVD installed in the optical drive. The workstation
will boot to the DVD and initiate the HP Vision Field Diagnostics utility.

5. Follow the HP Vision Field Diagnostic prompts to troubleshoot the workstation.

Using the HP Memory Test utility
This section describes how to access the HP Memory Test utility.

NOTE: The HP Memory Test is a comprehensive memory diagnostic utility that is run as a stand-alone
application, outside of HP Vision Field Diagnostics.

If the workstation is booted from a CD, a separate boot CD will be required to use the memory diagnostic.
Hence, HP recommends that a USB key be used to boot the diagnostic utilities. It is faster than using
a CD, and it accommodates both Memory and Vision diagnostics.

1. In the C:\VisionDiagnostics\ directory, double-click on the MemoryDiagISO.exe file. A setup menu
appears.

2. Follow the setup prompts to create a bootable ISO image of the memory diagnostic utility on a
DVD.

3. Turn off the workstation and restart it with the DVD installed in the optical drive. The workstation
will boot to the DVD and initiate the memory diagnostic utility.

4. Follow the diagnostic prompts to troubleshoot workstation memory.
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User interface
The HP Vision Field Diagnostics application provides six major functions, accessible through Tabs.
These functions are:

● Survey — Your current system hardware information.

● Test — List all diagnostics available for your system. Tests are started there.

● Status — This screen shows progress and status of currently running diagnostics.

● History — All past diagnostics runs and status are listed there.

● Errors — All past diagnostics failures are listed there.

● Help — User help about HP Vision Diagnostics.

There are also some common operations that are part of the utility. They include:

● Exit Diagnostics button — This button will close HP Vision Diagnostic application and reboot your
system. Any running test will be aborted.

● Reload button — If available, this button will rescan your system hardware and reload the
diagnostics without the need to restart your entire system.

● Save button — If available, save your system survey, test history or error data as an HTML file to
a floppy disk or a USB key drive.

Survey tab
The Survey tab shows your system hardware information, organized into eleven Categories (for example
"Processors") and device instances (for example "Processor 1").

The amount of information displayed can be controlled by selecting a combination of View Level and
Category.

The View Levels include:

● Overview — shows high level summary of the system hardware. This is the default view level.

● Summary — gives limited configuration data for each specific Category.

● Advanced — offers more technical and low-level data for the computer-savvy user.

The Categories Levels include:

● All — Shows all Categories.

● Architecture — Shows system architecture information such as high level PCI devices, low level
SMBIOS, CMOS and PCI configuration space data.

● Audio — Shows all embedded and add-on audio devices.

● Asset Control — Shows asset control related information such as product name, serial number,
asset tag, and universal unique ID information.

● Communication — Shows communication devices such as serial, parallel, USB, network,
Firewire, modem, and Bluetooth ports and devices.

● Graphics — Shows all embedded and add-on video cards.

● Input Devices — Shows user input devices such as all connected mice and keyboards.

● Memory — Shows system memory information.
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● Miscellaneous — List any devices or data that doesn't belong to any other Category.

● Processors - Shows system processors.

● Storage — Shows mass storage devices such as floppy drives, optical drives, SATA, SAS hard
disk drives and controllers, as well as any RAID arrays.

● System — Shows information about motherboard devices such as fans and cables.
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Test tab
The Test tab lists all available diagnostics. The lists have been tailored according to your system
configuration. Individual test may be selected or unselected. The following Test Modes exist:

● Quick — This test selection was picked to perform quickly while covering your entire hardware.
Test parameters cannot be modified.

● Complete — This test selection offers all available tests and may take a long time to complete.
Test parameters cannot be modified.

● Custom — Like Complete this test selection offers all available tests. The test parameters may be
modified to fit specific needs. For advanced users only!

By default, the three test modes do not display prompts and require no interaction. If errors are found,
they are displayed when testing is complete.

However, for each test type, you may also optionally add interactive tests by clicking the Include
interactive tests box under Test mode. Selecting interactive tests provides the maximum control over
the testing process. The diagnostic software will prompt you for input during tests.

NOTE: Memory can not be tested from within the HP Vision Field Diagnostics application. To test the
memory in your workstation, exit HP Vision Field Diagnostic, boot to either the CD or USB flash drive
and select HP Memory Test from the boot menu.

The Duration of Test options control the duration of the test sequence. The following options are
available:

● Number of loops — A test selection will run once by default. Enter a positive number to make a
test selection run many times.

● Total test time (hours:minutes) — Alternatively, the test selection can be set to run for a specified
amount of time. This does not guarantee that all tests will run if the entered time is less than the
necessary time to run all the tests

● Stop at first error— Check this option to stop test execution as soon as one error is encountered.

The following Test Controls exist:

● Select All, Unselect All button — This button toggles to select or unselect all the tests from the
test selection tree.

● Expand, Collapse button — This button toggles to expand or collapse the test selection tree.

● Start Test button — Click this button to start executing all selected tests. HP Vision Field
Diagnostics will automatically switch to the Status tab in order to keep track of the test execution
and status.

WARNING! Once started, do not reboot or power off your computer until all the tests have been
completed.

To begin testing:

1. Select the Test tab.

2. Select the type of tests you want to run: Quick, Complete, or Custom.

3. Include optional interactive tests by selecting Include interactive tests.

4. Choose how you want the test to be executed, either Number of Loops or Total Test Time. When
choosing to run the test over a specified number of loops, enter the number of loops to perform. If
you want the diagnostic test for a specified time period, enter the amount of time in minutes.
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5. Click the Start Test button to start the testing. The Status tab, which allows you to monitor the
progress of the tests, is automatically displayed during the testing process. When the tests are
complete, the Status tab shows whether the devices passed or failed.

6. If errors are found, go to the Errors tab to display detailed information and recommended actions.
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Status tab
The Status tab shows the overall progress and status of the test scenario as well as the progress and
status of each test. The color coded status are black, blue, green, red, and orange.

The Status tab colors are:

● Waiting (black) — when no test is running

● Running (blue) — when at least one test is currently running

● Passed (green) — when all tests have run successfully, meaning that no hardware error or defect
have been detected

● Failed (red) — when thee tests have detected at least one error with your system

● Canceled (orange) — when the test scenario has been explicitly canceled, in which case no pass
or fail conclusion can be drawn

The available data is:

● Current Loop — Shows the current execution loop out of total number of loops specified in the
Test panel.

● Test Time — Shows the total time elapsed since the beginning of the test execution.

● Test Complete — Shows the number of tests successfully completed out of the total number of
test to execute.

● Cancel button — Push the Cancel button to immediately terminate all currently running tests.

History tab
The History tab shows the history of the past test executions.

The History Log displays all tests that have been executed, the number of times of execution, the number
of times failed, the date each test was executed, and the time it took to complete each test. The Clear
History button will clear the contents of the History Log.

The contents of the History Log may be saved as a HTML file to either floppy or USB flash drive by
clicking the Save button.

Errors tab
The Errors tab displays detailed information about any errors found, as well as any recommended
actions.

The Error Log displays the tests for devices that have failed during the diagnostic testing and includes
the following columns of information.

● The Device section displays the device tested.

● The Test section displays the type of test run.

● The Times Failed is the number of times the device has failed a test.

● The Defect Code provides a numerical code for the failure. The error codes are defined in the Help
tab.

● The Description section describes the error that the diagnostic test found.

● The Reason section describes the likely cause of the error.
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● The Recommended Repair will give a recommended action that should be performed to resolve
the failed hardware.

● The Warranty ID is a unique error code associated with the specific error on your computer. When
contacting the HP Support Center for assistance with a hardware failure, please be prepared to
provide the Warranty ID.

● The Clear Errors button will clear the contents of the Error Log.

The contents of the Error Log may be saved as a HTML file to either floppy or USB flash drive by clicking
the Save button.

Help tab
The Help tab contains a Vision Help section, and a Test Components section. This tab includes search
and index features. You may also review the HP End User License Agreement (EULA), as well as the
HP Vision Field Diagnostic application version information on this tab.

The various sections located here are:

● The Vision Help section contains information on the major functions of HP Vision Field Diagnostics.

● The Test components section provides a description of each test, as well as the parameters that
may be adjusted when running in Custom test mode.

● The Defect codes section contains information on the numerical error code that may appear in the
Errors tab.

● The Memory test tab section provides information on the HP Memory Test application that may be
launched from the boot menu.

● The HP Support section provides information on obtaining technical support from HP.
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Saving and printing information in HP Vision Field Diagnostics
You can save the information displayed in the HP Vision Field Diagnostics Survey, History and Errors
tabs to a diskette or a USB flash drive. You can not save to the hard drive. The system will automatically
create an html file that has the same appearance as the information displayed on the screen.

1. Insert a diskette or USB flash drive if running HP Vision Field Diagnostics from CD.

2. Click Save in the bottom on any of the Survey, History or Errors tabs. All three log files will be saved
regardless of from which tab the Save button was clicked.

3. Select the drive onto which you will save the log files and click the Save button. Three html files
will be saved to the inserted diskette or USB flash drive.

NOTE: Do not remove the diskette or USB key until you see a message indicating that the html
files have been written to the media.

4. Print the desired information from the storage device used to save it.

NOTE: To exit HP Vision Field Diagnostics, click the Exit Diagnostics button at the bottom of
the screen. Be sure to remove the USB flash drive or CD from the optical drive.

Self-troubleshooting with HP Insight Diagnostics (only
available for the HP xw9400 Workstation)

HP Insight Diagnostics is an offline diagnostic utility that allows you to perform system testing. With this
utility, you can test your system hardware and view the hardware configuration information for your
system.

For the latest diagnostics utility, visit www.hp.com/go/workstationsupport. Select your product, click
Download drivers and software, select your operating system, and then choose Diagnostic from the
list of possible downloads.

NOTE: If you do not have the Documentation and Diagnostics CD, visit http://www.hp.com/go/
workstationsupport. Select Download Drivers and Software from the left menu under Tasks, and
follow the instructions to locate the latest documentation and diagnostics information available for your
workstation.

For more information on using HP Insight Diagnostics when running the application, click the Help tab
or see the Service and Technical Reference Guide at http://www.hp.com/support/
workstation_manuals.

HP troubleshooting resources and tools
This section provides information on the HP Help and Support Center, E-support, and Helpful Hints for
troubleshooting.

HP Help and Support Center
The HP Help and Support Center is a customized HP user interface that enhances the Windows XP
Help and Support Center Help feature. This customized utility allows you to access specific information
about your HP Workstation such as configuration information by clicking Start > Help and Support
Center. The interface also provides customized help and support links to the HP Web site related to
your HP Workstation.

NOTE: The customized HP Help and Support Center is not available on Windows XP Professional
x64 Edition or on Linux.
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E-support
Online access and support resources include Web-based troubleshooting tools, technical knowledge
databases, driver and patch downloads, online communities, and product change notification services.

The following Web sites are also available to you:

● http://www.hp.com—Provides useful product information.

● http://www.hp.com/support/workstation_manuals—Provides the latest online documentation.

● http://www.hp.com/go/workstationsupport—Provides technical support information for your
workstation.

● http://www.hp.com/support—Provides a listing of the worldwide technical support phone numbers.
Access the telephone numbers by visiting the Web site, then select your region, and click Contact
HP in the upper-left corner.

● http://www.hp.com/support/workstation_swdrivers—Provides access to software and drivers for
your workstation.

Troubleshooting a problem
To help you troubleshoot problems with your system, HP provides the Business Support Center (BSC).
The BSC is a portal to an extensive selection of online tools. To access BSC and troubleshoot a problem
with your workstation, complete the following:

1. Visit http://www.hp.com/go/workstationsupport.

2. Under the Business Support Center menu on the left, select Troubleshoot a problem.

3. Under Select your product (center window), select Workstations (under personal
computing).

4. Under Select your product, continue with selections as appropriate to your workstation series and
model, and to the problem you are troubleshooting.

Instant Support and Active Chat
HP Instant Support is a set of Web-based support tools that automate and speed up the resolution of
desktop computing, tape storage, and printing problems.

Active Chat enables you to electronically submit a support ticket to HP over the Web. When you submit
a support ticket, Active Chat collects information about the computer and pass it to an online support
specialist. The collection of information might take up to 30 seconds depending on the computer
configuration. When you submit a support ticket, you receive a confirmation message containing your
case ID, the support hours for your location, and the estimated time of response.

For more information about HP Instant Support and Active Chat and how to use them, visit
http://www.hp.com/hps/hardware/hw_professional.html.

NOTE: This feature is not available on Windows XP Professional x64 Edition or on Linux.

Customer Advisories, Customer and Security Bulletins, and Customer Notices
To find advisories, bulletins, and notices:

1. Visit http://www.hp.com/go/workstationsupport.

2. Select the desired product (for example, HP Workstation xw6000).
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3. Under Resources for <your selected product> (for example, HP Workstation xw6000), select
See more…

4. Under Self-Help resources: in the center of the window, choose the desired action and appropriate
information in the scroll list to view the index.

Product Change Notifications
Product Change Notifications (PCNs) are proactive notifications for product changes occurring within a
30-60 day window of the effective date of the change in the manufacturing process. PCNs give
customers advanced notice of changes to their product, such as an updated BIOS version that they may
need to qualify prior to the change taking place. The latest PCNs are located at: http://www.hp.com/go/
workstationsupport.

Helpful hints
If you encounter a problem with your workstation, monitor, or software, the following provides a list of
general suggestions that help you isolate and focus on the problem before taking further action.

At startup

● Verify that the workstation and monitor are plugged into a working electrical outlet.

● Remove all diskettes from your system before turning it on.

● Verify that the workstation is turned on and the green power light is on.

● If you have installed an operating system other than the factory-installed operating system, check
to be sure that it is supported on your system by visiting http://www.hp.com/go/quickspecs.

● Verify that the monitor is turned on and the green monitor light is on.

● Turn up the brightness and contrast controls of the monitor if the monitor is dim.

● If your workstation has multiple video sources and only a single monitor, the monitor must be
connected to the source selected as the primary VGA adapter. During startup, the other monitor
connectors are disabled; if the monitor is connected to one of these ports, it will not function after
Power-on Self Test (POST). You can select the default VGA source in Computer Setup (F10).

During operation
● Look for blinking LEDs on the front of the workstation. The blinking lights are error codes that will

help you diagnose the problem. Refer to the Diagnostic lights and audible (beep) codes section of
this document for information on interpreting diagnostic lights and audible codes.

● Press and hold any key. If the system beeps, then your keyboard is operating correctly.

● Check all cables for loose or incorrect connections.

● Wake the workstation by pressing any key on the keyboard or the power button. If the system
remains in suspend mode, shut down the system by pressing and holding the power button for at
least four seconds, then press the power button again to restart the system. If the system does not
shut down, unplug the power cord, wait a few seconds, then plug it in again. If it does not restart,
press the power button to start the workstation.

● Reconfigure your workstation after installing a non–plug and play expansion board or other option.
Refer to the Hardware installation problems section of this document for instructions.

● Be sure that all required device drivers have been installed. For example, if you have connected
a printer, you must install a printer driver.
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● If you are working on a network, plug another workstation with a different cable into the network
connection. There might be a problem with the network plug or cable.

● If you recently added new hardware, remove the hardware and verify if the workstation functions
properly.

● If you recently installed new software, uninstall the software and verify if the workstation functions
properly.

● If the screen is blank, plug the monitor into a different video port on the workstation if one is
available. Alternatively, replace the monitor with a monitor that you know is working properly.

● Upgrade the BIOS. A new release of the BIOS might have been released that supports new features
or fixes your problem.

● For more detailed information, see the troubleshooting chapter in the Service and Technical
Reference Guide at http://www.hp.com/support/workstation_manuals.

Customizing the monitor display
You can manually select or change the monitor model, refresh rates, screen resolution, color settings,
font sizes, and power management settings. To do so, right-click the desktop, then click Properties to
change display settings. For more information, see the online documentation provided with the graphics
controller utility or the documentation that came with your monitor.

Power-On Self Test error messages
The POST is a series of diagnostic tests that runs automatically when the system is turned on. Audible,
visual, or both message occur before the operating system boots if the POST encounters a problem.
POST checks the following items to ensure that the workstation system is functioning properly:

● Keyboard

● Memory modules

● Diskette drives

● All mass storage devices

● Processors

● Controllers

● Fans

● Temperature sensors

● Cables (front/rear panels, audio, and USB ports)

Find additional information about POST error messages in the Service and Technical Reference
Guide, which is available at http://www.hp.com/support/workstation_manuals.

Basic troubleshooting
This section provides guidance on troubleshooting problems that you might encounter during the initial
setup process. Additional troubleshooting information is available in the Service and Technical
Reference Guide at http://www.hp.com/support/workstation_manuals.
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General problems
You might be able to easily resolve the general problems described in this section. If a problem persists
and you are unable to resolve it yourself or if you feel uncomfortable about performing the operation,
contact an HP customer care center, or contact an authorized dealer or reseller. For a list of support
telephone numbers for your region, visit http://www.hp.com/support, select your region, and click
Contact HP in the upper-left corner.

Table 5-1  General installation problems

Problem Cause Solution

Workstation appears locked
up and will not turn off when
the power button is pressed.

Software control of the
power switch is not
functional.

Press and hold the power button for at least four seconds until the
workstation turns off.

Workstation will not respond
to USB keyboard or mouse.

Workstation is in
Standby mode.

Press the power button to resume from standby mode.

CAUTION: When attempting to resume from standby mode, do not hold
down the power button for more than four seconds. Otherwise, the
workstation shuts down and you might lose your data.

Workstation date and time
display is incorrect.

RTC (real-time clock) battery
might need to be replaced.

NOTE: Connecting the
workstation to a live AC
outlet prolongs the life of the
RTC battery.

Reset the date and time using Computer Setup (F10). If the problem
persists, replace the RTC battery. See the Service and Technical
Reference Guide for instructions on installing a new battery, or contact
an authorized dealer or reseller for RTC battery replacement.

Workstation pauses
periodically.

Network driver is loaded and
no network connection is
established.

Establish a network connection, or use Computer Setup (F10) to disable
the network controller.

Cursor will not move using
the arrow keys on the
keypad.

The Num Lock key
might be on.

Press the Num Lock key. The Num Lock light should not be on if you want
to use the arrow keys. The Num Lock key can be disabled (or enabled)
in Computer Setup (F10).

Cannot remove workstation
cover or access panel.

Solenoid hood lock, featured
on some systems, is locked.

Unlock the solenoid hood lock using Computer Setup (F10). The solenoid
hood lock FailSafe Key, a device for manually disabling the solenoid hood
lock, is available from HP. You will need the FailSafe Key in case of
forgotten password, power loss, or workstation malfunction. (This solution
not applicable to the xw8000/xw9000 series.)

The panel is locked
(xw6000/xw8000/xw9000
series).

Use the key located on the back of the unit to unlock the panel.

Poor performance is
experienced.

Processor is hot. 1. Make sure the airflow to and from the workstation is not blocked.

2. Make sure the fans are connected and working properly.

3. Make sure the processor heatsink is installed properly.

Hard drive is full. Transfer data from the hard drive to create more space on the hard drive.

The user has memory
installed in a single channel
instead of in both channels.

Ensure DIMMs are matched and installed in both memory channels for
best performance.
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Problem Cause Solution

System does not power on
and the LEDs on the front of
the workstation are not
blinking.

System unable to power on
with power applied.

CAUTION: Internal components might be powered even when the
system is off. To prevent damage, disconnect the workstation power cord
before you remove a component.

To resolve this problem, choose one of the following:

A. Press and hold the power button for less than 4 seconds. If the hard
drive LED turns green, then:

1. Remove the expansion cards one at a time and try holding the power
button again for less than 4 seconds.

2. The problem might be on the system board. Contact HP for
assistance.

B. Press and hold the power button for less than 4 seconds. If the hard
drive LED does not illuminate green:

1. Verify that unit is plugged into a working AC power outlet.

2. Open the access panel and verify the power button harness is
properly connected to the system board.

3. Verify that all power supply cables are properly connected to the
system board.

4. Check the power supply functionality.

a. Disconnect the AC power.

b. Disconnect ALL internal power supply cables from the system board.

c. Plug in the AC power.

If the power supply fan spins and the BIST* LED lights, the power supply
is functional. The problem might be on the system board. Contact HP for
assistance.

If the power supply fan does not spin or the BIST* LED does not light, the
problem might be in the power supply. Contact HP for assistance.

* For BIST information, see the Service and Technical Reference Guide for your workstation.

Hardware installation problems
You might need to reconfigure the workstation when you add or remove hardware, such as an additional
optical drive. If you install a plug and play device, some operating systems automatically recognize the
device and configure the workstation. If you install a non–plug and play device, you must reconfigure
the workstation after installing the new hardware.

Table 5-1  General installation problems (continued)
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Table 5-2  Hardware installation problems

Problem Probable Cause Recommended Solution

A new device is not
recognized as part of

the system.

Device is not seated or
connected properly.

Ensure that the device is properly and securely connected and that pins
in the connector are not bent down.

Cables of new external
device are loose or power
cables are unplugged.

Power switch of new
external device is not turned
on.

Turn off the workstation, turn on the external device, then turn on the
workstation to integrate the device with the workstation system.

When the system advised
you of changes to the
configuration, you did not
accept them.

Reboot the workstation, and follow the instructions for accepting the
changes.

A plug and play board might
not automatically configure
when added if the default
configuration conflicts with
other devices.

Use Computer Setup (F10) to reconfigure or disable devices to resolve
the resource conflict.

Workstation will not start. Wrong memory modules
were used in the upgrade or
memory modules were
installed in the wrong
location.

1. Review the documentation that came with the system to determine
if you are using the correct memory modules and to verify the proper
installation.

2. If you still cannot resolve the issue, contact Customer Support.

3. Observe the beeps and LED lights on the front of the workstation.
See Diagnostic lights and audible (beep) codes on page 42 to
determine possible causes.

Workstation will not shut
down.

Proper steps were not
followed.

1. Shut down the operating system software.

2. Manually turn off power to the workstation by pressing and holding
the power button for four seconds.

CAUTION: Manually turning off the power bypasses the standby
state and can result in loss of data.

3. To reconfigure the power button to work in On/Off mode, run
Computer Setup (F10).

For more information about using Computer Setup, refer to the Service
and Technical Reference Guide, which is available through a link on
the Documentation and Diagnostics CD (http://www.hp.com/support/
workstation_manuals).

Diagnostic lights and audible (beep) codes
This section describes the front panel light (LED) error and operation codes as well as the audible codes
that might occur before or during the POST.
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Table 5-3  Diagnostic lights and audible codes

Activity Possible cause Recommended action

Green Power LED On. No
beeps.

Workstation on.

None

Green Power LED blinks
every two seconds.** No
beeps.

Workstation in Suspend to
RAM mode (select models
only) or normal Suspend
mode.

Green Power LED is off.**
No beeps.

Workstation in Suspend to
Disk or “Hibernate” mode.

Green Power LED blinks
three times, once per
second.** No beeps

Workstation in Suspend to
RAM mode (select models
only) or normal Suspend
mode.

Green Power LED blinks
four times, once per
second.** No beeps.

Workstation in Suspend to
Disk or “Hibernate” mode.

NOTE: ** — The BIOS option you select controls the green LED function during these suspend modes.

For the following LED activity and beeps, the beeps are heard through the chassis speaker. Blinks and beeps repeat for 5 cycles, after
which, only the blinks continue to repeat.

Red Power LED blinks two
times, once every second,
followed by a two-second
pause. Two beeps.

Processor thermal
protection activated by either
of the following methods:

● A fan might be blocked
or not turning.

● The heatsink and fan
assembly is not
properly attached to the
processor.

CAUTION: Internal components might be powered even when the
system is off. To prevent damage, disconnect the workstation power cord
before you remove a component.

1. Ensure that the workstation air vents are not blocked and the cooling
fan is running.

2. Open the access panel, press power button, and verify that the
processor fan is spinning. If the processor fan is not spinning, make
sure the fan cable is plugged into the system board header. Ensure
the fan is fully and properly seated or installed.

3. If fan is plugged in and seated properly, but is not spinning, the
problem might be in the processor fan. Contact HP for assistance.

4. Verify that the fan assembly is properly attached. If problems persist,
there might be a problem with the processor heatsink. Contact HP
for assistance.

Red Power LED blinks three
times, once every second,
followed by a two-second
pause. Three beeps.

Processor not installed (not
an indicator of bad
processor).

1. Verify that the processor is present.

2. Reseat the processor.

Red Power LED blinks four
times, once every second,
followed by a two-second
pause. Four beeps.

Power failure (power supply
is overloaded)

CAUTION: Internal components might be powered even when the
system is off. To prevent damage, disconnect the workstation power cord
before you remove a component.

1. Open the access panel and ensure the following connections are
secure on the system board:

◦ 24–pin main power (all systems)

◦ 4–pin CPU (xw4000 series)

◦ 8–pin CPU (xw6000/xw8000/xw9000 series)

◦ 4–pin memory (xw8000/xw9000 series)
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Activity Possible cause Recommended action

NOTE: Memory connector pin configurations vary, and can
have either a 4–pin, 6–pin, or 8–pin configuration, depending
on workstation series and model.

2. Check if a device is causing the problem by removing all attached
devices (such as hard, diskette, or optical drives, and expansion
cards.) Power on the system. If the system enters the POST, power
off and replace one device at a time; repeat this procedure until
failure occurs. Replace the device that is causing the failure.
Continue adding devices one at a time to ensure all devices are
functioning properly.

3. Check the power supply functionality.

a. Disconnect the AC power.

b. Disconnect ALL internal power supply cables.

c. Plug in the AC power.

If the power supply fan spins and the BIST* LED lights, the power supply
is functional. The problem might be on the system board. Contact HP for
assistance.

If the power supply fan does not spin or the BIST* LED does not light, the
problem might be in the power supply. Contact HP for assistance.

Red Power LED blinks five
times, once every second,
followed by a two-second
pause. Five beeps.

Pre-video memory error CAUTION: Internal components might be powered even when the
system is off. To prevent damage, disconnect the workstation power cord
before you remove a component.

1. Reseat DIMMs.

2. Replace DIMMs one at a time to isolate faulty module.

3. Replace third-party memory with HP memory.

4. The problem might be on the system board. Contact HP for
assistance.

Red Power LED blinks six
times, once every second,
followed by a two-second
pause. Six beeps.

Pre-video graphics error. CAUTION: Internal components might be powered even when the
system is off. To prevent damage, disconnect the workstation power cord
before you remove a component.

1. Reseat the graphics card.

2. The problem might be on the graphics card. Contact HP for
assistance.

Red Power LED blinks
seven times, once every
second, followed by a two-
second pause. Seven
beeps.

System board failure (ROM
detected failure prior to
video).

1. Clear CMOS.

NOTE: Refer to the Service and Technical Reference Guide for
your workstation model for detailed information on clearing CMOS.

2. The problem might be on the system board. Contact HP for
assistance.

Table 5-3  Diagnostic lights and audible codes (continued)
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Activity Possible cause Recommended action

Red Power LED blinks eight
times, once every second,
followed by a two-second
pause. Eight beeps.

Invalid ROM based on bad
checksum.

CAUTION: Internal components might be powered even when the
system is off. To prevent damage, disconnect the workstation power cord
before you remove a component.

1. Clear CMOS.

NOTE: Refer to the Service and Technical Reference Guide for
your workstation model for detailed information on clearing CMOS.

2. Upgrade the ROM using SoftPaq, either from your hard drive, CD,
diskette, or USB removable device (for example., HP Drive Key).
See the ROM Flash section of the Service and Technical Reference
Guide at http://www.hp.com/support/workstation_manuals. SoftPaq
is a self-extracting executable, which contains instructions for its
use, that enables you to upgrade your ROM. To download the
Softpaq executable, visit http://www.hp.com/go/
workstationsupport.

3. The problem might be on the system board. Contact HP for
assistance.

Red Power LED blinks nine
times, once every second,
followed by a two-second
pause. Nine beeps.

System powers on but does
not boot.

● The problem might be on the system board. Contact HP for
assistance.

● The problem might be in the processor. Contact HP for assistance.

System does not power on
and LEDs are not blinking.
No beeps.

System unable to power on. CAUTION: Internal components might be powered even when the
system is off. To prevent damage, disconnect the workstation power cord
before you remove a component.

To resolve the problem, choose one of the following options:

Press and hold the power button for less than 4 seconds. If the hard drive
LED turns green, then:

1. Remove the expansion cards one at a time and try holding the power
button again for less than 4 seconds.

2. The problem might be on the system board. Contact HP for
assistance.

Press and hold the power button for less than 4 seconds. If the hard drive
LED does not turn on green then:

1. Check that unit is plugged into a working AC outlet.

2. Open the access panel and check that the power button harness is
properly connected to the system board.

3. Check that all power supply cables are properly connected to the
system board.

4. Check the power supply functionality

a. Disconnect the AC power.

b. Disconnect all internal power supply cables.

c. Plug in the AC power.

If the power supply fan spins and the BIST* LED lights, the power supply
is functional. The problem might be on the system board. Contact HP for
assistance.

If the power supply fan does not spin or the BIST* LED does not light, the
problem might be in the power supply. Contact HP for assistance.

* Some workstation models (such as the xw4550) do not have the BIST LED functionality. * For BIST information, see the
Service and Technical Reference Guide.

Table 5-3  Diagnostic lights and audible codes (continued)
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Calling technical support
At times you might encounter an issue that requires technical support. When you call technical support:

● Have your workstation readily accessible.

● Write down the workstation serial numbers, product numbers, model names, and model numbers
and have them in front of you.

● Note any applicable error messages.

● Note any add-on options.

● Note the operating system.

● Note any third-party hardware or software.

● Note the details of any blinking LEDs on the front of the workstation.

● Note the applications you were using when you encountered the problem.

● Note the power supply BIST status, if applicable.

NOTE: When calling in for service or support, you might be asked for the Product Number (example:
PS988AV) of your workstation. If your workstation has a Product Number, it is generally located next to
the 10- or 12-digit Serial Number of your workstation.

NOTE: Refer to Ventilation, COA label, and serial number label information on page 8 for the location
of the Serial Number label on your workstation. On most models, the serial number and product number
label are located at the rear of the workstation.

For a listing of all worldwide technical support phone numbers, visit http://www.hp.com/support, select
your region, and click Contact HP in the upper-left corner.

Locating warranty information
To locate base warranty information, see http://www.hp.com/support/warranty-lookuptool.

To locate an existing Care Pack, see http://www.hp.com/go/lookuptool.

To extend a standard product warranty, visit http://www.hp.com/hps/carepack. HP Care Pack Services
offer upgraded service levels to extend and expand a standard product warranty.
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